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Introduction  

This document has been prepared within the framework of the project “Novuss — 

Sport for Everyone”, co-financed under the European Union’s programme “Erasmus 

+”. 

The project was established with the purpose of collaboration for the establishment of 

an international network and closer cooperation among the stakeholders and 

organisations with the aim of developing novuss as a kind of sport within the European 

Union and across the globe. 

Project coordinator: 

• Novuss Sport ohne Barrieren e.V., Germany 

www.novuss-sport.de 

Project partners: 

• Latvian Federation of Novuss, Latvia 

www.novuss-lnf.lv 

• Peningi Koroonamänguklubi, Estonia 

www.peningi.planet.ee 

• Stowarzyszenie Novuss Polska, Poland 

www.novuss.pl 

More details of the project are available on the website:  

www.novuss-sport.org 

 

Project printing partner:    

wabe e.V. is a non-commercial organisation based in Erlangen (Germany), established 

in 1987. The main objective of the organisation is integration of people with mental 

disorders into the labour market.  

Website: https://www.wabe-erlangen.com 
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1 BASIC RULES OF THE GAME 

Not a part of this document. 

See the current rules of the game: effective from 1 January 2017. 

2 COMPOSITION OF THE PANEL OF REFEREES 

The panel of Referees of the competition shall be appointed and approved by the local 

novuss section, novuss federation or local organiser of the event. 

The panel of Referees shall consist of the Commissioner, Chief Referee, Senior Referees 

and Secretary. 

Depending on the scale of competition, the composition of the Panel of Referees may 

vary according to the scale of competition. 

A Senior Referee shall be appointed for refereeing each separate zonal game. 

2.1 Chief Referee 

The Chief Referee shall be responsible for the course of the competition according to the 

rules and approved regulations.  

His/her duties shall be: 

• To approve the game calendar, perform the draw for the competition; 

• To manage the work of referees and make the final decision in relation to any 

protests filed, as well as on any other matters which may arise during the 

competition; 

• To approve the report of the competition; 

• To approve the final results of the competition and submit those to the founding 

organisation along with the report. 

The Chief Referee shall be authorised to: 

• Release from refereeing any referees failing to perform their duties or violating the 

rules, procedures or discipline during the competition; 

• To exclude from the competition participants violating the rules of the competition, 

conducting themselves in a rude manner or committing other violations; 

• To cancel or postpone the competition when the event is not possible because of 

non-preparation of the competition venue (space, inventory, lighting etc.); 

• To cancel the competition in cases of necessity to introduce changes in the game 

programme or calendar; 

• To cancel an erroneous decision of the Senior Referee. 
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Orders of the Chief Referee shall be binding on all the members of the Panel of Referees, 

participants of the competition and their representatives. 

2.2 Senior Referees 

Senior Referees shall:  

• manage individual, pair or team competitions among regional zones or groups; 

• verify compositions of the participating teams; 

• prior to commencement of competition — verify conformity of the inventory to the 

requirements — height, geometrical parameters of the table, conformity of 

inventory to the standards, conformity of the participant’s uniforms, puck and cue 

(including during the competition); 

• register violations of rules committed by the participants and impose penalty 

sanctions accordingly registering them in the report; 

• determine during the game whether the disc is “light” or “dark”, where necessary 

— using a light (torch). Moving the game disc is prohibited!  

• resolve complicated and disputable situations at the table of the game; 

• following completion of zonal or group competitions, submit to the Chief Referee 

reports and tables of the competition.  

2.3 Referees 

During the competition, functions of referees shall be performed by the participants 

themselves, where necessary, inviting the Senior Referee. During the set, the function 

of referee shall be performed by the player who does not have the right to strike at that 

moment. The participant entered into the report as the first shall fill in the report after each 

set, announces the result and indicates the player who has the right to the first strike in 

the current set. After the game, the report, signed by both participants, must be handed 

over to the Senior Referee of the competition immediately. 

 

2.4 Commissioner 

The Commissioner shall be appointed by the founding organisation. 

Commissioner’s duties: 

• to evaluate the quality of the venue (space, lighting, inventory etc.); 
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• to provide recommendations to the organisers of the competition for elimination of 

any deficiencies detected; 

• to evaluate the course of the competition; 

• to file a competition report to the founding organisation. 

 

3 TYPES AND NATURE OF THE COMPETITIONS 

Novuss competitions are subdivided as follows: 

• individual (singles) — men and women. The result of the competition is recorded 

for each player individually. 

• pairs — men, women and mixed. The result of the competition is recorded for each 

pair. 

• teams – men, women and mixed. The results of individual games are recorded as 

the total amount of points gained by the team. Regulations may govern the record 

in a different way (for example, the total amount of points gained by the team may 

consist of the results of individual and pair games. 

The types and procedures of competitions shall be provided for in the regulations. 
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4 FORMAT OF THE TOURNAMENT 

Theformat of the tournament (tournament mode) shall describe the structure of the 

tournament. A novuss competition shall consist of several rounds. Each round shall 

consist of several sets to determine the winner of the round. The number of rounds and 

number of sets shall be determined by the regulations of each competition. 

Desirable characteristics of the format of the tournament: 

• The final rating must reflect the actual skills of the player with the utmost precision; 

• The format of the tournament must motivate each player to reach their maximum 

performance in each game; 

There is not such a concept as an “ideal” format of a tournament. Each format of a 

tournament has its pros and cons.  

The following formats of tournaments are the most common: 

• League or everybody against everybody 

+ The final result reflects the relative level of players very precisely; 

+ Planning: when planning the tournament, match-ups between competitors and 

the time of their games are already known; 

- Not suitable for tournaments with a large number of participants; 

- Risk of tactical considerations; 

- The winner is usually not decided as a result of direct competition between the 

two best players. 

• Swiss system 

+ Exciting games throughout the entire tournament, since the players with nearly 

the same level of skills play each other; 

+ Suitable for a large number of participating players who are obliged to be 

present throughout the tournament; 

- The opportunity to get a better starting position in the case of a tactical loss at 

the beginning of the tournament; 

- In the case of an average result, the rating does not reflect the player’s skills 

very precisely. 
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• Knock-out system (K.-o.) or double elimination system 

+ Suitable for a large number of participants; 

+ Exciting games, convenient for spectators, but each match-up leads to one 

player being eliminated; 

- An early game between two leading players inevitably leads to a bad final 

positioning of the defeated player. 

- Many players are knocked out of the competition very early and have no 

opportunity to gain tournament experience. 

• Ranked system 

The principle is very similar to the knock-out system, with the difference that all 

the participants fight for their positions till the very end of the tournament. 

4.1 Single league or everybody against everybody 

A tournament according to the round-robin system (also called “everybody against 

everybody”, in English: “Round Robin“) — this is a form of tournament in which each 

participant in the tournament plays an equal number of times with all the participants.  

The number of rounds according to the round-robin system: 

• equal to the number of participants in the event of an of odd number of participants  

(13 participants = 13 rounds); 

• number of participants — 1 in the event of an even number of participants 

(14 participants = 13 rounds); 

Optimum and recommended number of participants for a single-day tournament - max. 

14 in the same category.  

For a tournament with 15-20 participants, it is recommended to use a sub-group system 

combined with a round-robin system, furthermore, the results of the sub-group are carried 

over to the next level group. Depending on the desirable number of games, sub-groups 

may consist of 4-8 participants, i.e., 3-7 rounds per group. 

Example involving 18 participants: 

• participants are divided into 3 sub-groups (6 players in each) and play 5 rounds 

according to the round-robin system; 

• according to the results, participants are divided into groups to fight for their 

positions and play 5 rounds according to the round-robin system: 

o Players finishing 1st and 2nd in each group continue fighting for 1st-6th 

place; 
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o Players finishing 3rd and 4th in each group continue fighting for 7th-12th 

place; 

o Players finishing 5th and 6th in each group continue fighting for 13th-18th 

place. 

Points are accumulated for each win and draw. Upon completion of the tournament, a 

ranking table shall be drawn up based on the score achieved. Should players have an 

equal number of points, additional criteria apply (individual games or calculated ratios) 

determined in the competition’s regulations.  

Pairs are drawn according to the Berger tables where the first player starts the first set: 

• 3 or 4 players: 

Table: 1 2 

1 round 2-3 1-4 

2 round 4-3 1-2 

3 round 3-1 2-4 
 

• 5 or 6 players: 

Table: 1 2 3 

1 round 3-4 1-6 2-5 

2 round 5-3 6-4 1-2 

3 round 2-6 3-1 4-5 

4 round 1-4 6-5 2-3 

5 round 5-1 4-2 3-6 
 

• 7 or 8 players 

Table: 1 2 3 4 

1 round 4-5  2-7 3-6 1-8 

2 round 7-3  6-4 8-5 1-2 

3 round 3-1 2-8 4-7 5-6 

4 round 8-6 7-5 1-4 2-3 

5 round 4-2 3-8 5-1 6-7 

6 round 8-7 1-6 2-5 3-4 

7 round 7-1 5-3 6-2 4-8 
 

• 9 or 10 players 

Table: 1 2 3 4 5 

1 round 1-10 2-9 3-8 4-7 5-6 

2 round 7-5 9-3 8-4 10-6 1-2 

3 round 4-9 3-1 2-10 5-8 6-7 

4 round 8-6 10-7 9-5 2-3 1-4 

5 round 3-10 5-1 6-9 4-2 7-8 

6 round 9-7 2-5 1-6 10-8 3-4 

7 round 6-2 4-10 5-3 7-1 8-9 

8 round 4-5 1-8 2-7 3-6 10-9 

9 round 8-2 6-4 7-3 9-1 5-10 
 

• 11 or 12 players 

Table: 1 2 3 4 5 6 

1 round 6-7 2-11 3-10 4-9 5-8 1-12 

2 round 11-3 8-6 9-5 10-4 12-7 1-2 

3 round 5-10 3-1 4-11 2-12 6-9 7-8 

4 round 10-6 9-7 12-8 11-5 1-4 2-3 

5 round 4-2 3-12 5-1 6-11 7-10 8-9 

6 round 12-9 10-8 11-7 1-6 2-5 3-4 

7 round 5-3 4-12 6-2 7-1 8-11 9-10 

8 round 1-8 11-9 12-10 2-7 3-6 4-5 

9 round 8-2 6-4 7-3 5-12 9-1 10-11 

10 round 4-7 1-10 2-9 3-8 12-11 5-6 
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11 round 11-1 7-5 8-4 9-3 10-2 6-12 
 

  



Recommendations for Referees 
 

 

• 13 or 14 players 

Table: 1 2 3 4 5 6 7 

1 round 7-8 2-13 3-12 4-11 5-10 6-9 1-14 

2 round 13-3 9-7 10-6 11-5 12-4 14-8 1-2 

3 round 6-11 3-1 4-13 5-12 2-14 7-10 8-9 

4 round 12-6 10-8 11-7 14-9 13-5 1-4 2-3 

5 round 5-1 4-2 3-14 6-13 7-12 8-11 9-10 

6 round 11-9 14-10 12-8 13-7 1-6 2-5 3-4 

7 round 4-14 5-3 6-2 7-1 8-13 9-12 10-11 

8 round 12-10 14-11 13-9 1-8 2-7 3-6 4-5 

9 round 7-3 6-4 5-14 8-2 9-1 10-13 11-12 

10 round 2-9 13-11 1-10 14-12 3-8 4-7 5-6 

11 round 10-2 7-5 8-4 9-3 6-14 11-1 12-13 

12 round 5-8 1-12 2-11 3-10 4-9 14-13 6-7 

13 round 13-1 8-6 9-5 10-4 11-3 12-2 7-14 
 

• 15 or 16 players 

Table: 1 2 3 4 5 6 7 8 

1 round 1-16 2-15 3-14 5-12 7-10 6-11 4-13 8-9 

2 round 12-6 10-8 11-7 16-9 13-5 1-2 15-3 14-4 

3 round 4-15 3-1 2-16 6-13 5-14 7-12 8-11 9-10 

4 round 13-7 14-6 15-5 16-10 11-9 1-4 12-8 2-3 

5 round 8-13 4-2 5-1 6-15 3-16 7-14 9-12 10-11 

6 round 1-6 12-10 13-9 14-8 15-7 16-11 2-5 3-4 

7 round 10-13 5-3 6-2 7-1 8-15 9-14 4-16 11-12 

8 round 15-9 13-11 14-10 4-5 1-8 2-7 3-6 16-12 

9 round 11-14 6-4 7-3 8-2 12-13 10-15 9-1 5-16 

10 round 3-8 14-12 15-11 4-7 2-9 16-13 1-10 5-6 

11 round 10-2 11-1 8-4 9-3 6-16 12-15 7-5 13-14 

12 round 16-14 5-8 1-12 15-13 3-0 4-9 2-11 6-7 

13 round 9-5 7-16 10-4 11-3 12-2 8-6 14-15 13-1 

14 round 3-12 16-15 6-9 1-14 4-11 5-10 2-13 7-8 

15 round 11-5 9-7 8-16 14-2 12-4 13-3 10-6 15-1 
 

 

Tables in Excel format or software such as Swiss Master may be used for the 

organisation and refereeing of the competition. 
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4.2 Swiss system 

A Swiss system can be best characterised as a special form (brief version) of a round-

robin tournament. The draw for the first round is made, afterwards, the interim result after 

each round is determined. During the following rounds, the leader always plays against 

the player in 2nd place; the 3rd placed player — against the player in 4th place etc. 

However, the possibility of two games between the same two players is ruled out. Thus, 

if the same players are in the leading positions after 2 tours, the first one will play against 

the third player (if those two have not played against each other yet), and the second one 

against the fourth one. 

Points are accumulated for each win and draw. Upon completion of the tournament, a 

ranking table shall be drawn up based on the score achieved. In the case of  

an equal number of points, additional criteria apply (individual games or calculated ratios). 

The optimum and recommended number of participants for a single-day tournament: ≥21 

in the same category. 

The recommended number of rounds in the tournament depends on the number of 

participants. In order to provide an impartial outcome, playing against one third of the 

opponents is recommended. 9 

For example: 

• for 16-19 participants - 6 rounds; 

• for 20-23 participants - 7 rounds; 

• for 24-27 participants - 8 rounds; 

• for 28-31 participants - 9 rounds; 

• ≥32 participants – ≥ 11 rounds. 

Organisation of tournaments according to the Swiss system requires software which 

allows pairs to be matched up for tournaments. 

One such software we can recommend is Swiss Master which facilitates the work of the 

referees. 

For more details, please see: https://www.schaakbond.nl/swiss-download 

 

  

https://www.schaakbond.nl/swiss-download
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4.3 A knock-out system or double elimination system (K.-o.) 

In the event of a large number of participants and limited time available for the 

tournaments, an Olympic system is used, also called the knock-out or play-off system. 

Mixed systems are frequently applied when qualification groups are organised at the 

beginning played on a round-robin basis, but the winner of the tournament is determined 

according to the knock-out system. 

• Knock-out system 

1          

2 

         

         

3 

         

         

4 

         

         

5 

         

        
 

6 

         

         

7 

         

         

8 

         

         

 

• Double elimination system - a system in which a participant is eliminated from 
the tournament after two losses. 
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4.4 Ranked system 

Just like the knock-out system, the ranked system is also used in the case of a large 

number of participants and limited time. 

The positive aspect is the fact that all the participants fight for the division of positions 

until the end of the tournament and thus gain tournament experience. 
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5 SOFTWARE FOR REFEREES 

5.1 Tables in Excel format for the round-robin system 

Tournament tables are available in Excel format simplifying the organisation of the 

tournament and refereeing for you. Tables are available for tournaments with the 

participation of 3 to 16 players. Structure of tables and use thereof is described below. 

Watch also this short video: https://youtu.be/xndpFPILDm8 

1) the following data must be entered at the beginning of the tournament (Table 

“Results”):. 

• Title of the tournament; 

• Points for a win, draw and loss; 

• Tournament location; 

• Rating or individual ratio of the player (if unavailable, enter 1,000, which is the 
lowest IC); 

• Rating factor — used as a multiplier for the calculation of ratings and assessing 
the difficulty of the tournament (Example: super-league tournaments: 1.3, first 
league tournaments: 1.0 and second- and third-league tournaments: 0.7); 

• Name, surname, country or region, title (for example, master, grandmaster); 

• Name, surname of the referee 

 

https://youtu.be/xndpFPILDm8
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2) The table “Protocols…” contains reports for 

printing:  

 

 
 
 
 
 
 
 
 
 
Select reports according to the regulations of the 

tournament. Reports are drawn up for games in sets 6, 

7, and 4. 

 

The player starting the set shall be responsible for filling in the report and for handing 

over a correctly filled report to the referee. Whereas, the opponent shall be obliged to 

verify the result entered.  

Both players shall be equally responsible for correct completion of the report and confirm 

correctness of the result entered by signing the report. 

 

3) The referee shall enter the round number and the 

table shall contain the games marked in orange, 

which must have their results entered. 

 

 

4) The referee enters the results of the game (sets). If 

the result is entered incorrectly, it shall be highlighted in dark-blue. Points are 

calculated automatically. This example contains 2 points for a win, 1 point for a draw 

and 0 points for a loss in the round. 

error when entering the 
result 

Draw 
(1 point) 

win for 1 player 
(2 points) 

       

 

round number  

marked games — the result is to 
be entered here  

round and table number 

player number 

Players 

results of six sets, the player marked with “x” 
shall start the set 
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5) After the results have been entered, division of places in the table is calculated 

according to the points, Berger coefficient, and set coefficient, thus facilitating 

analysis of results for referees. Calculation of places serve as an aid for the referees. 

Division of the places overall shall be determined by the referee according to the 

regulations of the tournament. 

 

 

  

division of the places by points, 
set coefficient, and Berger 
coefficient 

point
s 

Berger coefficient 
 

Set coefficient 
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5.1.1 Formulas used in the table 

• P = total of points gained within the tournament; 

• Berger coef. (Berger coefficient) = the total number of points gained by 

opponents that the player beat, and half of the total of points gained by 

opponents whom they player tied with; 

• Set coef. (set coefficient) = relation of a player’s won-lost sets; 

• Rounds = games or rounds played; 

• % = 𝑷 ÷ (𝑮𝒂𝒎𝒆𝒔 × 𝑷 𝒔𝒆𝒕. ) - player’s efficiency in the tournament in percentage 

terms, where P set. is the maximum number of points which you can obtain 

during the round; 

• ICop = average IC of the opponents; 

• ICst = IC of the participant at the beginning of the tournament; 

• R (rating points) = 1st place = 30 points; 2nd place = 29 points ... etc., multiplied 

by the rating coefficient. 

• IC+ (IC coefficient obtained during the round) 

 = 𝑃 − (𝑃𝑚𝑎𝑥.
𝐼𝐾𝑠𝑡.−𝐼𝐾𝑜𝑝.

10
+ 50) % × 10 

If (ICst - ICop)> 150, IC of the participant does not increase, but, in order to avoid 

decreasing it, it is necessary to gain at least 65% of the possible number of points 

(see “%” in the table). 

• ICfin (IC of the participant upon completion of the tournament) = 𝐼𝐾𝑠𝑡 + 𝐼𝐾 
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5.2 Swiss Master and auxiliary software 

Organisation of tournaments according to the Swiss system requires software which 

allows pairs to be matched up for tournaments. 

One such software we can recommend is Swiss Master which facilitates the work of 

the referees. 

More details are available here: https://www.schaakbond.nl/swiss-download 

The same software may also be used for round-robin games. When entering 

tournament data, it is necessary to enter the number of rounds according to the round-

robin system. 

The software is comparatively simple to use and may be used without any additional 

software.  

This description is based on version Swiss Master 5.5. 

5.2.1  Enter information about the tournament 

The majority of information does not require any explanation, and the essential nuances 

are listed below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

It is important here to enter the 
number of rounds and the 
number of the first table (for 
example, if there are several 
categories and the numbering 
does not start with 1). 
The number of participants will be 
automatically renewed upon entry. 

Select a suitable system for 
calculation of points. 
The remaining settings may 
be left as standard. 

If ratings or individual coefficients of 
players are available, it is recommended 
to use the following sequence of 
coefficients for the first 3 rounds. 

As of 4 rounds “rating” is the last. 
If rating is not used, this sequence may 
be left out from the 1st round. 

https://www.schaakbond.nl/swiss-download
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5.2.2  Entry of the list of participants (handwritten)  

1) Enter name, surname, rating (if available), country, sex and FIDE must be ticked. 

Confirm by pressing on “Add” (new players) or “Apply” (introduction of changes). 

 

 

 

 

 

 

  

1) In the case of an odd 

number of players, it is 

recommended to enter the missing player as 

“FREE”. FIDE does not have to be ticked, and 

the rating < than that of other players. 

 

2) After the entry of the participants, it is necessary 

to double-check the rating entered and sort the participants by rating. 
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5.2.3 An import of the list of participants is done in CSV 

format  

In order to import the list of participants in CSV format, you must comply with the format 

determined in the following file XML list - standard template.xlsx. Follow the instructions 

given in this section.  

Also watch a short video: 

• Swiss Master 5.5 https://youtu.be/ijhqE08gLMI 

• Swiss Master 5.7 https://youtu.be/EwY6RmeqqTo 

This format was tested on the following versions of Swiss Master:  

5.5, 5.6 and 5.7. 

1) Copy all the players to a single list of players in a previously prepared file XML list - 

standard template.xlsx. 

 

 

2) Save the document in CSV format: CSV (Comma delimited)(*.csv) 

 

 

 

  

Make sure that names of the players are entered 
correctly - in compliance with Swiss Master: IM, ....  
Make sure that no “0” has been entered, if it has 
then delete it! 

Enter the sex: for women 
“w”, for men no entry is 
required number the 

players 

https://youtu.be/ijhqE08gLMI
https://youtu.be/EwY6RmeqqTo
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3) Attach the CSV-file to the software Swiss Master. This step depends on the version 

of Swiss Master. 

a) Swiss Master 5.5 

 

 

 

 

 
 
 
 
 
 
 
 

b) Swiss Master 5.6 and 5.7 

 
 
 
If you received the following error message, you must 
open the CSV document in text editor and replace "," 
with ";" then repeat the above procedure. 

 
    

1) Select “Load Players” 

2) Press “Load” 

3) Select CSV format 

4), 5) select file and confirm it by 
pressing “Open” 

1) Select “Tools”=> “Options” => 
“Rating Lists” 

2) Select “Add…” 

3) Select CSV format 

4) Select file 

5) Confirm by pressing “Add” 
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4) Select the attached CSV file: 

 

 

 

 

 

 

 

 

 

5) Select participants and add them to the 

list of participants: 

 

 

 

 
1) In the case of an odd number of players, it is 

recommended to enter the missing player as 

“FREE”. FIDE does not have to be ticked, and the 

rating is < of other players, and confirm by 

pressing Add. 

 
 
 
 
 
 
 
2) Make sure that the participants are 

sorted correctly (according to rating). 

Otherwise, sorting is required. 

1), 2) Use the filter function to limit the list of 
participants 

3) Select participants = "Str" + the left 
mouse button 

4) Confirm by pressing Add Player 
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5.2.4 Import of the list of participants is done in XML format 

The current version of Swiss Master (Swiss Master 5.7) contains an import function in 

XML format.  Also watch a short video: https://youtu.be/79tZcoz_nAs 

6) Copy all the players to a single list of players in a previously prepared file XML list - 

standard template.xlsx. 

 

7) Activate the “Developer” menu 

File => Options => Customize Ribbon => tick “Developer” 

 

Make sure that names of the players are entered 
correctly - in compliance with Swiss Master: IM, ....  
Make sure that no “0” has been entered, if it has 
then delete it! 

Enter their sex: “M” for 
men, “F” for women 

number the 
players 

https://youtu.be/79tZcoz_nAs
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8) Export the list in XML format: 

 

 
 

9) Open an XML-document in txt editor, delete the yellow part and save the changes. 

 

10) Attach the XML-file to the 

software Swiss Master. 

 

 

Select: 
1) “Developer” 
2) “Export” 

3) Select the place where you want 
to save the file, for example, 
“Desktop” 

4) Enter the title of the document 

5) Confirm export by pressing 
Export. 

1) Select “Rating Lists” 

2) Select “FIDE XML list – standard 
rating”. 

3) Select the file 

4) Confirm by pressing Add. 
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11) Select the participants and import the 

data: 

 

 

 

 

 

 

 

12) Select participants and add them to the list of participants: 

 

 

 

 

 

 
3) In the case of an odd number of players, it is recommended to enter the missing player 

as “FREE”. FIDE does not have to be ticked, and the rating is < of other players, and 

confirm by pressing Add. 

 

Select the attached XML file  

1), 2) Use the filter function to limit the list of 
participants 

3) Select participants = "Str" + the left 
mouse button 

4) Confirm by pressing Add Player 
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4) Make sure that the participants are 

sorted correctly (according to rating). 

Otherwise, sorting is required. 

 

 

 

 

 

 

 

 

 

 

 

5.2.5 Import of the list of participantsis done in CSV format 

(Excel with macros) 

This selection describes the software (Excel with macros) for simplification of drawing 

up the list of participants. This description is based on the version Swiss Master 5.5. 

Also watch a short video: https://youtu.be/2dACXFL4N6k 

5) Copy all the players into a single list of players (file IK and Ranglist template.xls) 

from IC / rating. 

 

Sort the participants by alphabet: 

 Make sure that the names of the players are entered 
correctly - in compliance with Swiss Master: IM, IGM.  
Make sure that no “0” has been entered, if it has then 
delete it! 

https://youtu.be/2dACXFL4N6k
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6) Open the software file SwissMaster-CSV.xlsm 

 

7) Select players from the list 

 
 

 

 

 

 

 

 

 

 

 

 

8) Save the list by pressing ОК, indicating the location and entering the title of the 

document (for example “Playerslist”). 

 

 

 

 

 

 

 

 

  

Press “Search Players” to 
proceed 

Press “OK” to 
proceed 

Select the prepared list of players 
IC and Ranglist template.xls 

Enter at least the first two letters of the last name 

You can remove a participant from the list by 
double-clicking 

Select a player by double-clicking 

When you are finished, press “Add to List” 

Information for the user here “HELP” 

Indicate the location to 
save to 

Enter the file name 

confirm by pressing “Save” 
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9) Confirm creation of a CSV file 

 

 

 

 

 
10) Two files were created as a result:  

 

playerslist.xls – May be used for the 

round-robin system 

Players.csv — which may be used for 

import into Swiss Master 

  

11) Import of the CSV file into Swiss Master: 
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12) Tick the players (Ctrl-click or Shift-click) and confirm by pressing  

Add Player: 

13) In the case of an odd number of players, 

it is recommended to enter the missing player as 

“FREE”. FIDE does not have to be ticked, and the 

rating is < of other players, and confirm by 

pressing Add. 

 
 
 
 

 
14) Make sure that the participants are sorted correctly 

(according to rating). Otherwise, sorting is 

required. 
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5.2.6 Creation of pairs and game reports  

(Swiss Master standard) 

1) After drawing up the list of participants, it 

is necessary to perform the first round 

draw and create a match up. 

 

 

 

 

 

 

 

2) Print the reports and hand them out to the players. To ensure that table numbers are 

repeated as rarely as possible for players, it is recommended to assign table 

numbers in a mixed order manually, starting from the second round. 

The player who starts the first set is responsible for filling in the report and handing a 

correctly filled in report to the referee. Whereas, the opponent shall be obliged to 

verify the result entered.  

Both players are equally responsible for correctly filling in the report. 

 

  

 

 

5.2.7 Creation of pairs and game reports (export of game 

reports with table draws) 

Software created (Excel with macros) for drawing up reports for 4, 6 and 7 sets, as well 

as for the tables draw. The description is based on the Swiss Master versions 5.5 and 

5.7. To ensure that table numbers are repeated as rarely as possible for players, the 

program performs table draws automatically, which makes the work of the referees 

easier. 

1) The free player must be reset together with 
the last player manually — enter the numbers of 
the players and press “Force Pairing”. 
 

2) and press “Do Pairing”. 
 

Players tick the results with a cross.  
In order to avoid confusion in the 
number of sets, it is recommended 
to tick the sets won sets with the 
digit 1, but the sets lost — with a 0. 
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Also watch a short video: https://youtu.be/Kjx1dlMWT1k 

1) Swiss Master templates (.xlt format) shall be saved in the following location: 

C:\Program Files (x86)\Swiss Master\Templates 

We recommend saving the prepared document for tournaments in the same 

location. Copy the following document SwissMaster - Report Pairing - v.6.xlt 

 

 

 

 

 

 

2) After drawing up the list of 
participants, it is required to draw the 
first round and create a pair.  

 

 
 
 
 
 
 
 
 

3)  Export of game reports.  

standard documents 

new document 

1) The free player must be reset together with 
the last player manually — enter the numbers of 
the players and press “Force Pairing”. 
 

2) and press “Do Pairing”. 
 

1) Select “Excel 
Report Pairing” 
 

2) press “Load” 
 

2) Select a document which was saved at the 
following location 
C:\Program Files (x86)\Swiss Master\Templates 
and confirm by pressing “Open” 

3) and confirm by pressing “OK” 
 
 

https://youtu.be/Kjx1dlMWT1k
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4) The software draws up a list of pairs, and the referee is obliged to select the number 

of sets by pressing:  

• 4 sets; 

• 6 sets; 

• 7 sets. 
 
 
 
 

5) Depending on the selected 
number of sets, game 
reports are created, which 
may be printed by pressing 
on the printer symbol.  
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6) As a result, the following reports are printed:  

 

 
 
 
 
 
 
 
 
 
The player starting the set shall be responsible for 

filling in the report and for handing over a correctly filled 

report to the referee. Whereas, the opponent shall be 

obliged to verify the result entered.  

Both players are equally responsible for correctly 
filling in the report. 
 

5.2.8 Entry of results 

1) Entry of results: 

 

 

 

 

 

 

 

 

 

 

 

 

2) After the entry and verification of results, the 

following round is conducted (none of the 

pairs is made manually).  

 

1) Click the right mouse button to activate menu and select 
“Edit Results”. 

2) select a pair according to the 
report 

3) Select a result according to the 
report and confirm by pressing 
“Set Result” 
 
Alternatively, press a button on 
the keyboard depending on the 
result: 
1 = score 1:0 
2 = score 0:1 
3 = draw 

table number, numbers 
of players and tour 
 

Points gained at the 
particular moment 

Players 

results of six sets, the player marked with “x” 
shall start the set 
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5.2.9 Final report of the competition  

(Swiss Master standard) 

Swiss Master software provides several versions of final reports. Select at your own 

discretion. For example, a standard export in Excel format: 

 

 

 

 

5.2.10 Final report of the competition  

(Excel with macros) 

Developed software (Excel with macros) for export of final results of the tournament. 

Select the export file according to the number of rounds: 

• 11 rounds: Swiss Master 11 Rounds 200 users + Rating.xlt 

• 12 rounds: Swiss Master 12 Rounds 200 users + Rating.xlt 

• 13 rounds: Swiss Master 13 Rounds 200 users + Rating.xlt 

1) Swiss Master templates (.xlt format) shall be saved at the following location: 

C:\Program Files (x86)\Swiss Master\Templates 

We recommend saving the prepared 

document for tournaments in the 

same location. Copy (for example, 

11 layers and max. 200 players) the 

following document Swiss Master 11 

Rounds 200 users + Rating.xlt 
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2) Export of results: 

 
 

 

 

 

 

 

 

 

 

 
3) Export of results: 

 

  

 

 

 

 

 
 

4) As a result, you will receive information about the 

successful data export. Confirm by pressing OK:  

 

5) Final results are in the file  

Novuss competition table.xls 

 

 

 

 

 

 

 

 

select the location where you 
want to save the table 

enter the title of the table 

Press “Save” 
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Formulas used in the table: 

• Points = total amount of points gained within the tournament; 

• Rounds = games or rounds played; 

• ICop = average IC of the opponents; 

• ICst = IC of the participant at the beginning of the tournament; 

• R (rating points) = 1st place = 30 points; 2nd place = 29 points ... and so on 

multiplying by the rating coefficient 

• IC+ (IC coefficient obtained during the round) 

 = 𝑃 − (𝑃𝑚𝑎𝑥.
𝐼𝐾𝑠𝑡.−𝐼𝐾𝑜𝑝.

10
+ 50) % × 10 

If (ICst - ICop)> 150, IC of the participant does not increase, but, in order to avoid 

decreasing it, it is necessary to gain at least 65% of the possible number of points 

(see “%” in the table). 

• ICfin (IC of the participant upon completion of the tournament) = 𝐼𝐾𝑠𝑡 + 𝐼𝐾 
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5.2.11 Allow using Excel with macros 

To be able to use Excel documents with macros, you need to adjust the following 

settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 


